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Warranty and Service Policy
Product Warranty
DATAQ Instruments, Inc. warrants that this hardware will be free from defects in materials and workmanship under 
normal use and service for a period of one year from the date of shipment. DATAQ Instruments' obligations under 
this warranty shall not arise until the defective material is shipped freight prepaid to DATAQ Instruments. The only 
responsibility of DATAQ Instruments under this warranty is to repair or replace, at its discretion and on a free of 
charge basis, the defective material.

This warranty does not extend to products that have been repaired or altered by persons other than DATAQ Instru-
ments employees, or products that have been subjected to misuse, neglect, improper installation, or accident.

DATAQ Instruments shall have no liability for incidental or consequential damages of any kind arising out of the sale, 
installation, or use of its products.

Service Policy

1. All products returned to DATAQ Instruments for service, regardless of warranty status, must be on a freight-pre-
paid basis.

2. DATAQ Instruments will repair or replace any defective product within 5 days of its receipt.

3. For in-warranty repairs, DATAQ Instruments will return repaired items to the buyer freight prepaid. Out of war-
ranty repairs will be returned with freight prepaid and added to the service invoice.
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1. Introduction
Congratulations on your purchase of the DI-718B data logger/data acquisition system or DI-718Bx data logger/data 
acquisition system. The DI-718B is designed specifically to accept DI-8B modules — the world’s smallest fully func-
tional isolated analog signal conditioner.

Features
Common features of the DI-718B and the DI-718Bx are:

• 4,800 Hz maximum sampling rate—14,400 Hz when in Stand-alone data logger operating mode.

• 0.048 Hz minimum sampling rate—0.0017 Hz when in Stand-alone data logger operating mode.

• 14-bit A/D converter for high resolution measurement accuracy.

• The Stand-alone option allows the user to configure a recording session through their PC then record data in 
the field to an SD card (without being connected to their PC).

The DI-718B has the following additional features:

• Accepts up to 8 DI-8B amplifier modules accommodating virtually any industrial signal.

• USB or Ethernet interface options.

The DI-718Bx has the following additional features:

• Accepts up to 16 DI-8B amplifier modules accommodating virtually any industrial signal.

• Ethernet interface (optional external USB to Ethernet converter available — part number 101014-EA).

Analog Inputs
DI-718B models provide 8 fixed single-ended analog inputs that allow your analog signals to be converted into 14-bit 
digital data via an on board A/D converter. Differential input is not supported.

DI-718Bx models provide 16 fixed single-ended analog inputs that allow your analog signals to be converted into 14-
bit digital data via an on board A/D converter. Differential input is not supported.

Digital Inputs
The DI-718B provides two digital input channels for Remote Control Operations (Remote Start/Stop and Remote 
Events) that may be accessed using the Built-In Remote Control Jack (see "Built-In Remote Control Jack" on page 
17). Remote Control configuration and setup is easily accessible in both WINDAQ Acquisition software and in the 
Dataq Instruments Hardware Manager (when configuring the instrument for Stand-alone operation).

The DI-718Bx provides 8 software-programmable digital lines (bits) for input/output operations. These lines provide 
an interface for the transfer of data between user memory and a peripheral device connected to the instrument. Digital 
inputs can monitor alarms or sensors with TTL outputs, while digital outputs can drive TTL inputs on control or mea-
surement equipment. Remote control can be utilized with bits 0 and 1 and is easily accessed using WINDAQ Acquisi-
tion software or, for stand-alone models, in the stand-alone setup panel. To avoid using an analog input channel for 
Digital I/O, Channel 17 may be enabled as the digital channel. To use the Remote Control features in WINDAQ Acqui-
sition software either Channel 1 or Channel 17 must be configured as the Digital Input channel. Access digital I/O 
ports from the rear panel of the device. See "Digital I/O and Monitor Out" on page 26. Digital I/O bits are not avail-
able in Stand-alone mode except for Remote Control functions.
Introduction
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Software
All software required to record and playback waveforms is included with the purchase of any DI-718 model including 
WINDAQ Acquisition and Playback software and the Dataq Instruments Hardware Manager.

WINDAQ® Recording and Playback Software
WINDAQ Acquisition and WINDAQ Waveform Browser allow you to record and playback data acquired through your 
instrument. Whether using a Stand-alone model or a PC-connected instrument, WINDAQ is an invaluable resource for 
analyzing data. A special version (see "WinDaq Waveform Browser for SD" on page 34) of WINDAQ Waveform 
Browser (free) is required to read waveform data recorded to a Memory Card but is easily transferred to the standard 
version for more analytical features.

WINDAQ Acquisition software can be used to record waveforms directly and continuously to disk while monitoring a 
real time display of the waveforms on-screen. It operates and displays waveform signals in real time at the full sample 
rate of the instrument being used. WINDAQ is free but is restricted to recording throughput rates of 1108 Hz with a 
DI-718. An optional Unlock Code for high speed allows you to record data at the speed of your data acquisition sys-
tem. When you install the software, a trial version of High Speed is automatically installed allowing you to run the 
software for a limited time. Activation is required for continued use to ensure compliance with the Software License 
Agreement. This software is accessed through the Dataq Instruments Hardware Manager which can be found in the 
Start menu under the WINDAQ program group called Dataq Instruments Hardware Manager.

WINDAQ Waveform Browser playback software (also known as “WWB”) offers an easy way to review and analyze 
acquired waveforms. A built-in data file translator allows the user to display multiple waveforms acquired by 
WINDAQ Acquisition software or any of a wide range of data acquisition packages. The software’s disk-streaming 
design allows data files of any length to be graphically displayed rapidly, in normal or reverse time directions. Seven 
standard cursor-based measurements, frequency domain, and statistical analysis functions help simplify waveform 
analysis and interpretation. WINDAQ Waveform Browser is free and installed when installing WINDAQ Software.

The DATAQ Instruments Hardware Manager
The DATAQ Instruments Hardware Manager allows you to effectively manage and run multiple instruments installed 
and connected to your PC or your Network—or even over the internet. This software can be found in the Start menu 
under the WINDAQ program group called Dataq Instruments Hardware Manager. Access WINDAQ Acquisition 
software, upload data from your memory card, check the status of your memory card, format your memory card, con-
figure a Stand-alone data acquisition session, and more in this easy-to-use point and click environment. View the 
Help files by clicking on View Help in the Help menu or by pressing F1.

Help
All WINDAQ software utilizes context-sensitive help. Help may be accessed through the Help menu or by pressing the 
F1 key with any feature selected. This will take you directly to the Help topic most relevant to that particular function 
or feature. Help topics discuss in detail each function available in the software.
Introduction
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2. Specifications
Analog Inputs
Number of Channels: DI-718B: 8 configured for signal conditioned inputs

DI-718Bx: 16 configured for signal conditioned inputs
Channel Configuration: Defined by DI-8B Module
Input Impedance: Defined by DI-8B Module

Channel-to-Channel crosstalk rejection:
Offset temperature coefficient:
Digital Filtering:

Measurement Range:

Accuracy:

Resolution:
Gain (DI-718Bx only):
CJC Error:

Input offset voltage: Defined by DI-8B Module
-75db @ 100unbalance
0.25μV/°C
PC-connected models: Conditional over-sampling; peak/valley detect, 
last point, average, frequency, RMS
Stand-alone models: None
Defined by DI-8B module on a channel-by-channel basis.
Note: Not all DI-8B amplifier modules support ± excitation, but all 
support ± channel inputs.
DI-718B: ±0.25%FSR (1800 S/s, averaging mode)
DI-718Bx: ±.05%FSR ±50μV + 8B module + CJC error (test condi-
tions: 1 channel; 100 S/s; averaging mode)
±1 part in 8,192
1, 2, 4, 8 software selectable per channel.
±1.5°C plus 8B Module (spec measured at 25°C with no air circulation 
and Low Current Module configuration only).

A/D Characteristics
Type: Successive Approximation
Resolution: 14-bit
Monotonicity: ±2 LSB
Conversion Time: 69.4μs

Scanning Characteristics
Maximum sample throughput rate: PC-connected: 4,800 Hz

Stand-alone: 14,400 Hz*
*Dependent on SD card used. Low speed SD cards can sample up to 2,000
Hz; High speed cards can sample up to 14,400 Hz. Some high speed cards
cannot sample as high at 14,400 Hz but their capability can only be deter-
mined by trial and error (Model 101014-2G has been tested and approved).

Minimum sample throughput rate: PC-connected: 0.0034 Hz; Stand-alone: 0.0017 Hz
Maximum scan list size: DI-718B: 9 entries; DI-718Bx: 18 entries
Sample buffer size: 2kb
Specifications
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Digital I/O
Bits: DI-718B: 2 Inputs (Remote Storage and Remote Event)

DI-718Bx: 8 bi-directional (including Remote Storage/Event)
Input voltage levels: Min. required “1” 2V; Max allowed “0” 0.8V

Calibration
Calibration Cycle: One year

Ethernet Interface (optional USB to Ethernet converter available — part number 101014-EA)

Type: 10/100Base-T
Connector: RJ-45
Protocol: TCP/IP
Server Type: DHCP

USB Interface (DI-718B Models only)
Connector: USB
Protocol: USB 2.0

Removable Memory (Stand-alone Models only)
Type: Standard Secure Digital (not SDHDor SDxC). Sample rates of 2kHz 

require SD speeds of 133x or higher. Up to 2kHz require speeds of 13x or 
higher.

Capacity: 16MB to 2GB

Real Time Clock
Type: Date, hour, minute, second
Resolution: 1 second
Accuracy: 20 ppm

Controls (Stand-alone Models only)
Single push-button: Provides manual control over Record and Standby modes.

Indicators
Stand-alone models: Three color LED indicating Record, Standby, and Error conditions.
PC-connected models: Power LED

Transfer Rate to PC
Real Time: up to 4,800 samples per second
From SD Memory (Ethernet): up to 3,000 samples per second
Specifications
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General
Panel Indicators: Mode LED
Panel Controls: Control push-button (Stand-alone models)
Panel slots: Accepts SD-type flash memory
Input connectors: DI-718B: Two, removable sixteen position terminal blocks

DI-781BX: Four, removable sixteen position terminal blocks for signal-
conditioned channels.

Operating Environment: 0°C to 70°C
Enclosure: Aluminum base with steel wrap-around. Aluminum end-panels with plastic 

bezels. Aluminum top hatch for access to 8B backplane.
Dimensions: DI-718B: 5.4D × 4.1W × 1.5H in. (13.81D × 10.48W × 3.81H cm.)

DI-718Bx: 7.29W × 9L × 1.52H in. (18.52W × 22.86L × 3.86H cm.)
Weight: DI-718B: 14 oz. (397 grams) + DI-8B Modules

DI-718Bx: 2 lbs. 10 oz. (1.19 kg) + DI-8B Modules
Power Requirements: USB: 9 to 36 VDC, 2 watts + 8B modules

Ethernet: 9 to 36 VDC, 2.5 watts + 8B modules
Specifications
5





DI–718B and DI-718Bx Series Hardware Manual
3. Installation
Unpacking
The following items are included with each instrument. Verify that you have the following:

• DI-718B or DI-718Bx Series Instrument.

• DI-8B Module(s) as ordered.

• Communications cable (USB only - Ethernet models do not come with an Ethernet cable).

• Power cable.

• Jumpers to enable CJC (DI-718B only — jumpers for the DI-718Bx are located on the circuit board).

• Two (or four) removable 16 position screw terminal blocks.

• DI-718B models include a 3.5mm stereo phone plug for Remote Control Operations (“Built-In Remote Con-
trol Jack” on page 17).

• The WINDAQ Resource CD-ROM.

• DATAQ screwdriver for connecting signal leads to the screw terminal(s).

• This Hardware Manual.

If an item is missing or damaged, call DATAQ Instruments at 330-668-1444. We will guide you through the appropri-
ate steps for replacing missing or damaged items. Save the original packing material in the unlikely event that your 
unit must, for any reason, be sent back to DATAQ Instruments.

USB Device Installation
1. Disconnect all DATAQ Instruments USB devices from your Computer.
Installation
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2. Insert the WINDAQ Resource CD in your drive. The installation software should start automatically within 20 sec-
onds. If it does not, start it manually by double-clicking the Setup application (setup.exe) located on the root of 
the WINDAQ Resource CD.

3. In the “What do you want to do?” window, select “Install WinDaq Software” and click OK.

4. In the “Installing Software” window, select the “Install Software for DI-148, DI-158, DI-710, DI-715B, and DI-
718B(x) instruments” option and click OK.

5. In the “WinDaq Installation” dialog box, select the “Install Software” option and click OK to continue. If you 
wish to view the hardware documentation you may do so now by clicking on the appropriate radio button. Docu-
mentation will be saved to your hard drive during this installation.

6. In the “Welcome!” box, click OK to continue.

7. Read the License Agreement. If you accept the terms, click Accept and Continue. If you choose not to accept, 
click on the Do not accept and stop button to end the installation.

8. When prompted, enter your registration information (name and company) in the appropriate text boxes and click 
OK. Confirm your registration information before continuing.

9. When prompted, specify the directory where you want to install your WINDAQ software. It is recommended that 
you accept the default. If you have already successfully installed a DI-148, DI-158, DI-710, DI-715B, or DI-
718B instrument be sure to install to the same folder.

10. In the “Select an Interface” box select USB and click OK.

11. DO NOT connect your USB device or cable to your PC until installation is complete. If your device is currently 
connected, please disconnect it before continuing with this installation. Once your device is disconnected, click 
the OK button.

12. When prompted to Select a Program Manager Group specify a destination (or group window) in the Start Menu 
for WINDAQ software icons. It is recommended that you accept the default.

13. In the “Installation Option” dialog box specify whether you want all users to have access to WINDAQ software or 
just the current User. Click Yes to allow all users to have access, click No to allow just the current user to have 
access.

14. After WINDAQ Software installs, you will be prompted to install WINDAQ/XL Trial Version and Advanced 
CODAS Analysis software. If you wish to install either software click on Yes in the appropriate dialog box. Fol-
low the on screen prompts to complete installation.

15. Software installation is complete - you will now see a “Successful Installation” box - click OK to exit WINDAQ 

Installation.

You can now plug the device(s) into your PC and apply power (if required). You do not need to re-install this software 
when installing more DI- 71x USB devices to your PC.

Click on the appropriate program group (specified above — default is Start > Programs > WINDAQ) and click on 
“DATAQ Instruments Hardware Manager” to run WINDAQ software. All DATAQ Instruments software is located in 
the same program group.
Installation
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Ethernet Device Installation
Install WINDAQ Software and the DATAQ Instruments Hardware Manager. 

1. Insert the WINDAQ Resource CD in your drive. The installation software should start automatically within 20 sec-
onds. If it does not, start it manually by double-clicking the Setup application (setup.exe) located on the root of 
the WINDAQ Resource CD.

2. In the “What do you want to do?” window, select “Install Software” and click OK.

3. In the “Installing Software” window, select the “Install Software for DI-148, DI-158, DI-710, DI-715B, and DI-
718B(x) instruments” option and click OK.

4. In the “WinDaq Installation” dialog box, select the “Install Software” option and click OK to continue. If you 
wish to view the full hardware documentation you may do so now by clicking on the appropriate radio button. 
Documentation will be saved to your hard drive during installation.

5. In the “Welcome!” box, click OK to continue.

6. Read the License Agreement. If you accept the terms, click Accept and Continue. If you choose not to accept, 
click on the Do not accept and stop button to end the installation.

7. When prompted, enter your registration information (name and company) in the appropriate text boxes and click 
OK. Confirm your registration information before continuing.

8. When prompted, specify the directory where you want to install your WINDAQ software. It is recommended that 
you accept the default. If you have already successfully installed a DI-148, DI-158, DI-710, DI-715B, or DI-
718B instrument be sure to install to the same folder.

9. In the “Select an Interface” box select the Ethernet option and click OK to continue.

10. When prompted to Select a Program Manager Group specify a destination (or group window) in the Start Menu 
for WINDAQ software icons. It is recommended that you accept the default.

11. In the “Installation Option” dialog box specify whether you want all users to have access to WINDAQ software or 
just the current User. Click Yes to allow all users to have access, click No to allow just the current user to have 
access.

12. After WINDAQ Software installs, you will be prompted to install WINDAQ/XL Trial Version and Advanced 
CODAS Analysis software. If you wish to install either software click on Yes in the appropriate dialog box. Fol-
low the on screen prompts to complete installation.

13. Installation is complete - you will now see a “Successful Installation” box - click OK to exit WINDAQ Installa-
tion.

Ethernet devices can now be connected to your network or PC. Follow the appropriate instructions in “Installing an 
Ethernet Device Directly Connected to your PC or Connected via a Hub or Switch Where ONLY DI-71x Products are 
Installed” on page 10 “Installing an Ethernet Device via a Distributed Network Without a DHCP Server” on page 13, 
or “Installing an Ethernet Device via a Distributed Network with a DHCP Server” on page 14 of this manual for your 
specific network connections configuration.

Click on the appropriate program group (specified above — default is Start > Programs > WINDAQ) and click on 
“DATAQ Instruments Hardware Manager” to run WINDAQ software. All DATAQ Instruments software is located in 
the same program group.
Installation
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Installing an Ethernet Device Directly Connected to your PC or Connected 
via a Hub or Switch Where ONLY DI-71x Products are Installed
Installation of an Ethernet device directly connected to the network card on your computer requires you to change the 
IP address of your network card.

Note: When installing an Ethernet device directly connected to your PC you MUST use a crossover cable (provided).

Installation of an Ethernet device via an Ethernet hub/switch containing ONLY DI-71x products also requires you to 
change the IP address of your network card.

Note: For hubs that do not have an auto-switching sensor (usually older hubs) you must not use a crossover cable.

1. Install software (see “Ethernet Device Installation” on page 9).

1. Find the Network Connections on your computer (usually in the Control Panel).

2. Double-click on the Local Area Connection icon.

3. Click on the Properties button.
Installation
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4. Select Internet Protocol (TCP/IP) in the “This connection uses the following items” window and click on the 
Properties button.

5. Click on the General tab.

6. Select the radio button Use the following IP address.

7. Enter 169.254.0.1 in the space provided for the IP address.
Installation
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8. Enter 255.255.0.0 in the space provided for the Subnet mask.

9. Click on the OK button to close the Internet Protocol (TCP/IP) Properties dialog box then click on the OK but-
ton in the Local Area Connection Properties dialog box for the changes to take effect.

10. You will now be able to see the device in the DATAQ Instruments Hardware Manager (you may have to click on 
the Update List button).
Installation
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Installing an Ethernet Device via a Distributed Network Without a DHCP 
Server
Installation of an Ethernet device connected to a distributed network that does not have a DHCP server or where the 
DHCP server is turned off requires you to obtain an IP address from your system administrator.

Note: In the illustration above, the Hubs could instead be routers with DHCP turned off (i.e., a static IP assigned net-
work). Contact your system administrator for details about your network.

1. Have the system administrator designate an IP address for your device.

2. Install software (see “Ethernet Device Installation” on page 9).

3. Plug the device into your network and apply power.

4. Open the DATAQ Instruments Hardware Manager software.

5. In the dropdown command list (lower left-hand corner), select Static IP. The Manage IP Addresses dialog box 
will open.

6. Click on the MAC address of your device in the list of displayed MAC addresses (the MAC address of your 
device can be found on the silver sticker located on the bottom of your device).

7. Enter the IP address your system administrator assigned to you in the New IP Address text boxes.

8. Click on the Set Static button. Your device will appear in the list of available devices in the main DATAQ Instru-
ments Hardware Manager window. It may take more than 15 seconds for your device to appear in the list. If you 
get a “No Devices Found” error after following the above instructions, click the Update List button until the 
device appears in the list.

Note: These instructions change the settings inside the device. If you move the device to a DHCP-enabled network 
(i.e., where IP addresses are assigned automatically by a DHCP server or router) you will need to change the device 
settings using the DATAQ Instruments Hardware Manager. See the DATAQ Instruments Hardware Manager help file 
for complete details.
Installation
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Installing an Ethernet Device via a Distributed Network with a DHCP Server
Installation of an Ethernet device connected to a distributed network that has a DHCP server (i.e., a DHCP router 
automatically assigns IP addresses to each device connected to the network) requires no extra setup (i.e., it is a “plug 
and play” device).

Note: If you are unsure whether your network is DHCP-enabled or not, check with your system administrator before 
installing WINDAQ.

1. Install software (see “Ethernet Device Installation” on page 9).

2. Connect your Ethernet device to your Local Area Network.

3. Apply power to the device.

4. You will now be able to see the device in the DATAQ Instruments Hardware Manager (you may have to click the 
Update List button).

Activation of WINDAQ/High Speed Option
Activation is required for continued use of WINDAQ/HS (High Speed option) to ensure compliance with the Software 
License Agreement. The Software License Agreement can be found in the WINDAQ Software manual or in the 
WINDAQ program group (License.txt). The WINDAQ/HS Software may be activated through the Help menu by click-
ing on Unlock WINDAQ/HS or by waiting for the trial version to expire. Trial versions are good for 40 High Speed 
(over 1108 Hz throughput) recording sessions. The High Speed version may be purchased after the trial period 
expires through our online store or by phone. For help or for questions regarding Activation and/or the Software 
License Agreement, contact DATAQ Instruments Customer Support.

Dataq Instruments Hardware Manager
The Dataq Instruments Hardware Manager is installed when installing any DI-718B or DI-718Bx instrument. This 
software allows you to effectively manage and run multiple instruments installed and connected to your PC or your 
Network—or even over the internet. WINDAQ Data Acquisition Software and the Stand-alone Set Up program are 
Installation
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both accessed through the Dataq Instruments Hardware Manager. The Dataq Instruments Hardware Manager may be 
accessed through the Windows Program Manager Group as specified during installation (default is Start > Programs 
> WINDAQ > Dataq Instruments Hardware Manager). All available devices will automatically appear in the list box 
when you run the software. For help with the Dataq Instruments Hardware Manager access the Help Files using either 
the Help menu item or by pressing the F1 key to access context-sensitive help.
Installation
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4. Instrument Controls,         
Indicators, and Connections
Instrument Front Panel
The Front panel of both DI-718B and DI-718Bx instruments provide screw terminal connection ports for analog input 
signal leads. The DI-718B front panel also provides remote events and stop/start remote recording control features 
via a built-in remote control jack.

DI-718B Models
The two 16-port screw terminals on the front of the instrument are used to interface analog input channels 1 through 
8. Each channel has four terminals: In+, In-, Ex+, and Ex- for input signals and excitation (if required). Use the 
sticker located on the top of your instrument for quick reference to terminal access port designations.

Built-In Remote Control Jack
The built-in remote control jack located on the front panel of the DI-718B accepts a standard 3.5mm stereo phone 
plug (provided) and provides access to remote events and stop/start remote recording control features. Refer to the 
diagram on the front panel for quick reference.
Instrument Controls, Indicators, and Connections
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Connect signal leads inside the plug using the following diagram.

The Remote Control Feature can be used in Stand-alone mode or when using WINDAQ Acquisition software. See 
your software Help Files for instructions on setting up the Remote Control Feature.

Enabling Remote Storage (Start/Stop) when in stand-alone operating mode (see “Stand-alone data logger operation” 
on page 32) essentially adds another channel to the scan list and directly affects the per channel sample rate. For 
example, if your throughput rate is 1200Hz and you have 3 channels enabled (400Hz per channel), enabling Remote 
Storage will lower the per channel rate to 300Hz (throughput stays at 1200Hz).

DI-718Bx Models
The four 16-port screw terminals on the front of the instrument are used to interface analog input channels 1 through 
16. Each channel has four terminals: In+, In-, Ex+, and Ex- for input signals and excitation (if required). Use the 
sticker located on the top of your instrument for quick reference to terminal access port designations.

Installing DI-8B Modules
DI-8B modules are installed on the DI-8B backplane located on the instrument circuit board. DI-718B instruments 
require you to remove the front panel and bezel to access the backplane. DI-718Bx models provide a removable top 
hatch for easy access.

Installing DI-8B modules in DI-718B Instruments
DI-718B Series instruments can accept up to eight DI-8B modules. Modules are installed to the DI-8B backplane 
located on the instrument circuit board. You must remove the front panel and bezel and the ground lug on the rear of 
the instrument to access the DI-8B backplane.

1. Unplug the device and make sure there is no power to the instrument.

2. Remove the two screw terminal blocks on the front of the instrument.

Turn counterclockwise to remove.
Turn clockwise to tighten.

Ground

Event

Storage

Ground
Storage

Event

Leads

DI-718BX
Instrument Controls, Indicators, and Connections
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3. Remove the front panel and bezel by removing the two outside screws on the front of the instrument.

4. Remove the Ground Lug located on the back of the instrument.

5. Pull the circuit board apart from the casing to reveal the DI-8B backplane.

Two Front Screws 

Two Removable Screw Terminals 

Front Panel and Bezel 

Circuit Board (with DI-8B Backplane) 

Casing 

DI-8B Module 

Set Screw 

Ground Lug 

6. Plug the DI-8B module firmly into one of the channel positions clearly labelled on the backplane and secure with 
the set screw. DI-8B modules are installed on (or removed from) the socketed DI-8B backplane (located on the 
circuit board) and are secured with a non-removable mounting screw. Each channel position is labeled “CHAN-
NEL 1,” “CHANNEL 2,” etc. on the socketed backplane. The DI-8B modules can be mixed or matched in any 
combination suitable for the application and are identical in pinout and size, so it doesn't matter which module 
gets plugged into which channel position.

7. Using an erasable pencil write the module number of each DI-8B module installed on the sticker located on the 
top of the instrument to indicate which module is installed at each channel position.

Write Installed Modules in 
the spaces provided with an 

erasable pencil.

8. After all modules are installed and indicated on the sticker reassemble the instrument making sure not to over-
tighten the front screws. Note: If your are installing a thermocouple module you must enable the Cold Junction 
Compensation jumper for that channel (see “Enabling CJC in DI-718B Instruments” on page 21 for more infor-
mation).

Installing DI-8B modules in DI-718Bx Instruments
DI-718Bx Series instruments can accept up to sixteen DI-8B modules. Modules are installed to the DI-8B backplane 
located on the instrument circuit board. You must remove the top hatch to access the backplane.
Instrument Controls, Indicators, and Connections
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1. Unplug the device and make sure there is no power to the instrument.

2. Unscrew the six screws on the top of the instrument and remove the top hatch cover to reveal the DI-8B back-
plane.

3. Plug the DI-8B module firmly into one of the channel positions clearly labelled on the backplane and secure with 
the set screw. Note: Be sure to completely screw the module into place or vibrations could short the system. DI-
8B modules are installed on (or removed from) the socketed DI-8B backplane (located on the circuit board) and 
are secured with a non-removable mounting screw. Each channel position is labeled “CHANNEL 1,” “CHAN-
NEL 2,” etc. on the socketed backplane. The DI-8B modules can be mixed or matched in any combination suit-
able for the application and are identical in pinout and size, so it doesn't matter which module gets plugged into 
which channel position.

DI-8B Module

Front
Rear

Top Hatch

DI-8B Backplane and Circuit Board

Set Screw

4. Using an erasable pencil write the module number of each DI-8B module installed on the sticker located on the 
top hatch to indicate which module is installed at each channel position.

101058-B

Write Installed Modules in 
the spaces provided with an 

erasable pencil.

5. After all modules are installed and indicated on the sticker replace the top hatch and screw firmly into place. 
Note: If your are installing a thermocouple module you must enable the Cold Junction Compensation jumper for 
that channel (see “Enabling CJC in DI-718Bx Instruments” on page 22 for more information).
Instrument Controls, Indicators, and Connections
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Enabling CJC for Thermocouple Modules
Enable Cold Junction Compensation for each Thermocouple Input module installed. The CJC Enable Jumpers are 
located on the circuit board of the instrument. Note: If you are not using a Thermocouple Input Module on that chan-
nel be sure the jumper is disabled (removed or installed on only one pin) because this will affect the input signal

Enabling CJC in DI-718B Instruments
If you are installing a Thermocouple Input Module you must enable the Cold Junction Compensation jumper. Each 
channel has its own CJC enable jumper located in front of each channel position on the instrument circuit board (see 
also “Installing DI-8B modules in DI-718B Instruments” on page 18 for disassembly).

1. Unplug the device and make sure there is no power to the instrument.

2. Remove the front panel and bezel by removing the two screws on the front of the instrument.

3. Remove the ground lug from the back of the instrument.

4. Pull the circuit board apart from the casing to reveal the CJC Enable Jumpers.

5. Install a jumper onto the board for each channel that uses a thermocouple module. Eight jumpers are provided 
with the DI-718B for this purpose.

Note: If you are not using a Thermocouple Input Module on that channel be sure the jumper is disabled (removed 
or installed on only one pin) because this will affect the input signal.

6. After the DI-8B modules and jumpers are installed reassemble the instrument making sure not to overtighten the 
two front screws.

CHANNEL   8

CHANNEL   5

CHANNEL   4

CHANNEL   1

CHANNEL   2

CHANNEL   3

CHANNEL   6

CHANNEL   7

CJC Enable Jumpers Circuit Board with DI-8B Backplane

CasingFront of DI-718B
Instrument Controls, Indicators, and Connections
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Enabling CJC in DI-718Bx Instruments
If you are installing a Thermocouple Input Module you must enable the Cold Junction Compensation jumper. Each 
channel has its own CJC enable jumper located towards the front of the instrument on the instrument circuit board 
(see also “Installing DI-8B modules in DI-718Bx Instruments” on page 19 for disassembly).

1. Unplug the device and make sure there is no power to the instrument.

2. Unscrew the six screws on the top of the instrument and remove the top hatch cover to reveal the DI-8B back-
plane and the CJC Enable Jumpers.

TC
CH13

CHANNEL    1

CHANNEL    2

CHANNEL    3

CHANNEL    4

CHANNEL    5

CHANNEL    6

CHANNEL    7

CHANNEL    8

CHANNEL    9

CHANNEL    10

CHANNEL    11

CHANNEL    12

CHANNEL    13

CHANNEL    14

CHANNEL    15

CHANNEL    16

CJC Enable Jumpers

Circuit Board with 
DI-8B Backplane

Front

CJC Enable Jumpers

Casing

Rear

TC
CH1

TC
CH2

TC
CH3

TC
CH4

TC
CH5

TC
CH6

TC
CH7

TC
CH8

TC
CH9

TC
CH10

TC
CH11

TC
CH12

TC
CH14

TC
CH15

TC
CH16

3.  Each jumper is labelled on the circuit board as “TC CH#” where # is the channel number. Jumpers are installed 
on the circuit board in the “off” position. Move the jumper to the “TC” pins for each channel using a Thermocou-
ple module. Note: If you are not using a Thermocouple Input Module on that channel be sure the jumper is dis-
abled (in the “off” position) because this will affect the input signal.

TC
CH1

Install the jumper 
on the “TC” pins 
to enable CJC

Move jumper to the “Off” 
position when not using 
a Thermocouple Module

TC
CH1

4. After all necessary jumpers are installed, reassemble the instrument.
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Connecting Signals
Use the removable screw terminal blocks located on the front of the instrument to connect your analog input signals. 
Refer to the Screw Terminal Access sticker on the top of the instrument for pinout.

1. Insert the stripped end of a signal lead into the desired terminal directly under the screw.

2. Tighten the pressure flap by rotating the screw clockwise with a small screwdriver. Make sure that the pressure 
flap tightens only against the signal wire and not the wire insulation. Do not over-tighten.

3. Tug gently on the signal lead to ensure that it is firmly secured.

When an input signal is connected and WINDAQ Acquisition software is run, WINDAQ’s real time display immedi-
ately reveals the input waveform on your computer’s monitor.
Instrument Controls, Indicators, and Connections
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Instrument Rear Panel
The rear panel of DI-718B instruments provide access to power and interface connections, Ground, and a mode LED. 
The rear panel of stand-alone data logger models also provide a removable flash memory slot and a control button.

DI-718B Rear Panel
The Rear panel of your DI-718B Model can vary depending on your model. Stand-alone models add a removable 
storage slot, the LED Mode table, and a Control Button.

Power Input Jack
Power must be applied with the included power adapter or with an alternate appropriate source (9-36VDC, 15 watts 
max).

Ground Lug
This ground lug should always be connected to a solid chassis or earth ground. This connection is mandatory for the 
unit to meet CE guidelines.

Interface Port
The Interface port allows you to connect the instrument to your PC via USB or Ethernet cable.

Control Button (Stand-alone models only)
The Control Button can be used to stop or start recording data to your memory card (SD) when using the instrument 
as a stand-alone data logger. The Control Button can also be used to reconfigure the instrument to factory default set-
tings and to re-format memory card files left open due to power failure or other circumstance. The Control Button is 
inoperable while running WINDAQ Acquisition software. See “Control Button Operations” on page 26 for operations.

Mode LED Indicator
Indicates what mode the instrument is currently in. Use the chart on the rear panel of the instrument for quick refer-
ence. See “Mode LED Indicator” on page 27 for a list of modes.

DI-718B Rear Panel PC Connected Models 

DI-718B Rear Panel Stand-alone Data Loggers 
Instrument Controls, Indicators, and Connections
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Removable Storage (SD) Slot (Stand-alone models only)
Use any standard Secure Digital Card (SD) from 16MB to 2GB. Push card completely into slot. Press to release 
(eject) memory card when recording is complete. Please note that some memory cards may not be fast enough for the 
instrument. SD memory cards are available through the DATAQ web site (www.dataq.com) as are SD card readers 
(manufacturer varies). .

DI-718Bx Rear Panel
The Rear panel of your DI-718Bx Model can vary depending on your model. Stand-alone models add a removable 
storage slot, the LED Mode table, and a Control Button.

Ground Lug
This ground lug should always be connected to a solid chassis or earth ground. This connection is mandatory for the 
unit to meet CE guidelines.

Ethernet Port
The Ethernet port allows you to connect the instrument to your PC or network via an Ethernet cable. An optional  
USB to Ethernet converter is available to connect the instrument to your USB port (part number 101014-EA).

Control Button (Stand-alone models only)
The Control Button can be used to stop or start recording data to your memory card (SD) when using the instrument 
as a stand-alone data logger. The Control Button can also be used to reconfigure the instrument to factory default set-
tings and to re-format memory card files left open due to power failure or other circumstance. The Control Button is 
inoperable while running WINDAQ Acquisition software. See “Control Button Operations” on page 26 for operations.

Mode LED Indicator
Indicates what mode the instrument is currently in. Use the chart on the rear panel of the instrument for quick refer-
ence. See “Mode LED Indicator” on page 27 for a list of modes.

Removable Storage (SD) Slot (Stand-alone models only)
Use any standard Secure Digital Card (SD) from 16MB to 2GB. Push card completely into slot. Press to release 
(eject) memory card when recording is complete. Please note that some memory cards may not be fast enough for the 

Digital I/O and Monitor Out

ModeEthernet Power

DI-718BX Rear Panel PC Connected Models

DI-718BX Rear Panel Stand-alone Models
Instrument Controls, Indicators, and Connections
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instrument. SD memory cards are available through the DATAQ web site (www.dataq.com) as are SD card readers 
(manufacturer varies). 

Digital I/O and Monitor Out
Provides easy access to Digital I/O bits as well as Monitor Out. Use the DI-705 with CABL-7 to access these ports. 
See “DI-705 (for DI-718Bx models only)” on page 39 for connection and pinout.

Power Input Jack
Allows you to apply power to the instrument. Power should be applied using the included power adapter.

Power Switch
Controls power to the DI-718Bx instrument. 1 is on, 0 is off.

Control Button Operations
The Control Button can be used to stop or start recording data to your memory card (SD) when using the instrument 
as a stand-alone data logger. The Control Button can also be used to reconfigure the instrument to factory default set-
tings and to re-format memory card files left open due to power failure or other circumstance. The Control Button is 
inoperable while running WINDAQ Acquisition software.

Start Recording
To Start recording data to your memory card the Instrument must be in Standby Mode (Mode LED is Green). Press 
and hold the Control Button until the Mode LED turns off (about 1 second). Release the Control Button. The Mode 
LED will rapidly blink green to indicate the instrument is creating a new file. When the Mode LED slowly blinks red, 
data is being recorded. Each subsequent recording session creates a new file (numbered sequentially).

Stop Recording
To Stop recording data to your memory card the Instrument must be in Record mode (Mode LED is flashing red @ 1 
Hz). Press and hold the Control Button until the Mode LED turns off (about 1 second). Release the Control Button. 
Mode LED will rapidly blink red to indicate the instrument is closing the data file for use with playback and/or anal-
ysis software. Do not remove the memory card before the instrument completely closes the file. When Mode LED 
turns green the memory card may be removed. Removing the card before completion will cause Error Mode (Mode 
LED is orange).

Note: SD cards should be locked before inserting into a card reader. Your PC may try to change the flash card format 
whenever it reads the data on your SD (if not locked), causing it to lose the unique formatting required for DI-718B 
use. If the unique format used by the DI-718B is modified, the DI-718B may require you to reformat the memory card.

Formatting the Memory Card
Formatting the card completely removes all data. To format your memory card the instrument must be in Standby 
Mode (Mode LED is Green). Press and hold the Control Button until the Mode LED turns red (about 5 seconds). 
Release the Control Button. The Mode LED will blink red to indicate the Instrument is formatting the card. When the 
Mode LED changes back to green, formatting is complete. Mode LED should be green to indicate successful comple-
tion. Formatting is for use with the instrument used to format the card. To use a memory card with a different instru-
ment you will have to reformat the card.

Reconfigure Instrument
To configure your instrument to the default factory data acquisition session settings press and hold the Control Button 
during power up (i.e., while plugging the instrument in). Mode LED will flash bright green then dim to indicate that 
the instrument is configured. Release the Control Button. The default settings are: 8 channels enabled at 300 samples 
per second per channel sample rate.
Instrument Controls, Indicators, and Connections
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Fix Errors
The Control Button can also be used to fix some common operating errors. When the instrument is in Error mode, 
some action must be taken to fix the error before you can use it. Generally, the Control Button can be used to make 
the instrument operational. See the Error mode in “Mode LED Indicator” on page 27 for more information.

Mode LED Indicator
Indicates what mode the instrument is currently in. Use the chart on the rear panel of the instrument for quick refer-
ence. Use the table provided below for a more detailed description of each available state.

State Mode Description

Stand-alone data logger operation

Static Green Standby Instrument is powered and available for data acquisition operations. Memory card 
may be safely removed.

Flashing Green Busy Indicates the instrument is busy. Do Not Remove Memory Card.

Orange Error Possible errors include, but are not limited to:
SD removed prematurely: Memory card removed before the instrument had a 
chance to close the data file. Reinsert the card and Press the Control button to close 
the file. When steady green, memory card is closed and can be removed safely.
SD Lock: After initially pressing the Control button to begin recording data, two 
series of blinking Orange before reverting back to Green indicates that the memory 
card is locked. Use another card or unlock the current one. One series of blinking 
Orange before reverting back to Green indicates that the memory card is incompatible 
for use with the instrument. Use the recommended memory card available through 
DATAQ Instruments, Inc.
See also “Troubleshooting” on page 33.

Slow Flashing 
Red (@ 1Hz)

Record Indicates the instrument is acquiring and recording data to your memory card. Do Not 
Remove Memory Card.

Fast Flashing 
Red

Close Indicates the instrument is closing the recording session. Do Not Remove Memory 
Card. Each recording session must be completed before removing the card.

PC-connected operation

Slow Flashing 
Red (@ 1Hz)

Record Indicates the instrument is running and acquiring data for display and/or recording to 
disk. Occurs when WINDAQ Acquisition is running.

Green Standby Indicates WINDAQ has been deactivated and the instrument is in Standby Mode. The 
Mode LED Indicator will also flash green just before recording to disk to indicate ini-
tialization.
Instrument Controls, Indicators, and Connections
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5. Operation
Operation for PC-connected Models
PC-based models (DI-718B-U, DI-718B-E, DI-718Bx) are operated and controlled using WINDAQ Software. To 
begin displaying data on your monitor, make sure all wires and cables are properly connected and start WINDAQ 
Acquisition by pressing the Start WINDAQ button in the Dataq Instruments Hardware Manager (see “Dataq Instru-
ments Hardware Manager” on page 14). After data is recorded, use WINDAQ Waveform Browser to review your data. 
Consult the context-sensitive help files or your Fast Start WINDAQ Software Manual for directions on using the 
WINDAQ software package. Note: If your USB device experiences frequent lock ups, connect the Ground Lug to your 
PC ground. If the problem persists, please contact Technical Support.

Enabling/Disabling Digital Remote Control
To use the Remote Control features in WINDAQ Acquisition Software with DI-718B instruments Channel 1 or Chan-
nel 9 must be enabled as the Digital Input channel. For DI-718Bx instruments, Channel 1 or Channel 17 must be 
enabled as the Digital Input channel

Analog Input Channel Configuration
Enabling and configuring channels with the DI-718B and DI-718Bx in WINDAQ Acquisition software is different 
than enabling channels with other instruments and is not covered in the Help Files.

Enabling Channels for DI-718B Instruments
Use the Channel Selection grid to enable and configure channels. Access the channel selection grid by selecting 
Channels… in the Edit menu (in the SET-UP operating mode of WINDAQ software). Each box in this grid represents 
an input channel. An input channel is enabled by clicking in its channel box. The following channel selection grid is 
typical for a DI-718B. To use the Remote Control Functions (see also “Built-In Remote Control Jack” on page 17) of 
WINDAQ Acquisition software Channel 9 or Channel 1 must be enabled as the Digital Input Channel.
Operation
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Enabling Channels for DI-718Bx Instruments
Use the Channel Selection grid to enable and configure channels. Access the channel selection grid by selecting 
Channels… in the Edit menu (in the SET-UP operating mode of WINDAQ software). Each box in this grid represents 
an input channel. An input channel is enabled by clicking in its channel box. The following channel selection grid is 
typical for a DI-718B. To use the Remote Control Functions (Digital I/O can be accessed using the Digital I/O and 
Monitor Out port on the rear of the instrument. See “Digital I/O and Monitor Out” on page 26 for more information) 
of WINDAQ Acquisition software. Channel 17 or Channel 1 must be enabled as the Digital Input Channel.

EU Settings (DI-718B and DI-718Bx Instruments)
All waveform data is initially scaled, annotated, and displayed in volts, which in many cases is not very meaningful. 
Change EU (Engineering Units) Settings to give meaning to the displayed data. Instead of volts, your data can be 
scaled, annotated, and displayed in significant engineering units (i.e., PSI, RPM, lbs, ft/s, etc.). EU Settings proce-
dures are the same for both DI-718B and DI-718Bx instruments. Each DI-8B module has a sticker with information 
regarding Input (Units) and Output (Volts). This information should be used for EU Settings. For example, if using a 
DI-8B47K-05, the Input is 0ºC to +500ºC and the Output is 0V to +5V.

Select a channel then click on Engineering Unit Settings in the Edit menu. The Engineering Unit Settings dialog 
box will display:
Operation
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Enter the appropriate information in the available text boxes. For example, if using a DI-8B47K-05, the Input is 0ºC 
to +500ºC and the Output is 0V to +5V. Enter 5 in the Upper Level text box under Volts and 500 in the Upper Level 
text box under EU (5 volts = 500 degrees C). The Lower level text boxes should be 0 for both (0 volts = 0 degrees C). 
Enter the appropriate EU tag (here degrees C) Press OK to save the settings..

Operation for Stand-alone Models
Stand-alone Models (DI-718B-US, DI-718B-ES, DI-718Bx-S) can record data directly to a Secure Digital Card (SD) 
as well as recording data to a PC. When connected to a PC, data recording sessions may be configured and data may 
be acquired using WINDAQ Acquisition software (just the same as if the model were a PC-based instrument). This 
makes all the features of WINDAQ Acquisition software available including triggering, user annotation, user com-
mented event markers, appending, and stop/pause data recording (stand-alone data logger operation does not support 
these features).

When taking your stand-alone model out into the field to use as a stand-alone data logger, you can record data to an 
SD without the use of a PC. Data sessions can be configured for a specific job using the included configuration soft-
ware (installed when WINDAQ is installed). All data recorded to the memory card is fully WINDAQ compatible and 
can be converted then reviewed and analyzed with WINDAQ Playback software.

PC-connected operation
DI-718B and DI-718Bx Instruments enter PC Operation Mode when the instrument is connected to the PC (either 
directly or through a network) and the user initiates WINDAQ Acquisition software. As soon as PC Operation Mode is 
entered, the Control button is deactivated and all the features of WINDAQ Acquisition Software are accessible. Con-
sult the context-sensitive help files or your Fast Start WINDAQ Software Manual for directions on using the WINDAQ 
software package.

Note: When running WINDAQ Acquisition software over the internet, unpredictable latencies may occur, especially at 
higher sample rates. The unit generally will continue to acquire data after a latency - but there will be gaps in your 
data.

Networked operation as a data acquisition server (DI-718B-ES and DI-718Bx-S 
models)
The Ethernet option allows data access from anywhere on a local area network (LAN) or DHCP server. A DI-718B or 
DI-718Bx instrument configured for Stand-alone operation and containing an Ethernet interface transparently 
becomes like any other computer on the network, able to share data whenever and wherever it is needed. This can be 
over the LAN to a PC on the other side of the facility, or over the Internet to a PC on the other side of the world. Fur-
thermore, Stand-alone instruments can be easily added to existing networks. Its server functionality means that it does 
not require a dedicated network to operate efficiently. Data is locally stored to SD memory, where it is available for 
upload (using the Uploader software) only on demand and as network bandwidth permits. In this manner, Stand-alone 
instruments with Ethernet interfaces are fully compatible with the intrinsic non-preemptive nature of Ethernet net-
works.
Operation
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Stand-alone data logger operation
Use your Stand-alone model as a stand-alone data logger to record a WINDAQ-compatible waveform file onto a 
Secure Digital Card (SD). After recording, insert the memory card into your card reader to access the data file. The 
data file can then be opened with WINDAQ Waveform Browser Software for SD allowing analysis and review fea-
tures. See “WinDaq Waveform Browser for SD” on page 34 for more information regarding WINDAQ Waveform 
Browser for SD software.

Data may be recorded using a circular FIFO memory configuration allowing you to record data nearly indefinitely or 
in a non-circular configuration allowing you to stop recording when your memory card is full. Select the desired 
memory configuration using the Stand-alone Set Up software inside the Dataq Instruments Hardware Manager.

Note: SanDisk SD memory cards have a lifetime expectancy of about 100,000 write actions. Each time data wraps 
you will use one write action; each singular data file uses two write actions (start and stop). If used properly a mem-
ory card will last years. See your memory card’s specifications to determine lifetime expectancy.

The Stand-alone Set Up Panel
The Stand-alone Set Up software (installed with WINDAQ—accessible in the WINDAQ program group through the 
Dataq Instruments Hardware Manager) allows you to customize each data recording session before taking the instru-
ment out into the field. The default settings (i.e., if you do not configure the instrument) are 8 single-ended channels 
enabled at 300Hz per channel sample rate. The default configuration can be reset at any time on the instrument by 
holding the Control button in when applying power. Context-sensitive Help is provided within the configuration soft-
ware. Press F1 to access Help topics related to the currently displayed feature. You must run the software with the 
device properly installed and connected to your PC.

Operation
To use your instrument as a stand-alone data logger follow these steps:

1. Configure the Instrument using the Set Up software or by re-setting to the default.

2. Connect signal leads (“4. Instrument Controls, Indicators, and Connections” on page 17).

3. Apply Power to the instrument using the supplied Power Cable.

4. Insert the Secure Digital Card (SD) into the Removable Storage Slot.

5. If the memory card has not been used with your instrument, format the memory card before recording data. See 
“Formatting the Memory Card” on page 26 or use the Format SD Card command in the DATAQ Instruments 
Hardware Manager.

6. To Record Data to memory card: Press and hold the Control Button until the LED light turns off; release the Con-
trol button to initiate the recording session—initialization could last up to 30 seconds depending on memory card 
used. For Ethernet models you may also use the Start Recording to SD Memory command in the DATAQ Instru-
ments Hardware Manager. This creates a new file numbered sequentially on the memory card. See also “Start 
Recording” on page 26.

7. To Stop Recording Data to memory card: Press and hold the Control Button until the LED light turns off; release 
the Control button to end the recording session and close the data file. It could take up to 30 seconds to close the 
file depending on the memory card used. For Ethernet models you may also use the Stop Recording to SD Mem-
ory command in the DATAQ Instruments Hardware Manager. This creates a new file numbered sequentially on 
the memory card. See also “Stop Recording” on page 26.

8. Access SD data using the uploader software provided in installation (Ethernet models) or by removing the mem-
ory card and using a card reader. Data files open in WINDAQ Waveform Browser for SD (see “WinDaq Wave-
form Browser for SD” on page 34).
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Note: To read the data files, SDs MUST be locked before inserting into a card reader. If the SD is not locked, 
Windows may modify the file system and the SD will be unreadable to your instrument requiring you to reformat 
the card., some SDs may require you to reformat every time you review the data.

Troubleshooting
Use the following chart for errors and resolution.

Problem Possible Cause(s) Resolution
When attempting to initiate a 
recording session the LED blinks 
green for about 5-10 seconds then 
quickly blinks orange then back to 
green.

Memory card not inserted. Press memory card firmly into the 
slot until you hear a slight “click” 
to indicate proper insertion.

When attempting to initiate a 
recording session, LED blinks 
orange, then turns green.

SD is locked (write protected). Unlock the SD Card
Memory card is full. Reformat the memory card.
Memory card is unusable or damaged. You need a new memory card

Recording is initiated but only 
runs for a short time when LED 
blinks orange and stays orange.

Memory card read/write speed in SPI 
mode is too slow to record data as 
specified.

Try lowering the sample rate first.

If problem persists purchase a new 
card (recommended: Lexar Profes-
sional 133X 2 Gigabyte Secure 
Digital Flash Memory).

Recording is initiated in Circular 
Memory configuration, but when 
the file attempts to wrap, the LED 
blinks orange and stays orange.

Memory card read/write speed in SPI 
mode is too slow to record data in cir-
cular memory configuration.

LED is green but I cannot format a 
memory card.

The instrument is looking for a file 
that has not been closed (possible due 
to power failure).

Reinsert the correct memory card 
and press the control button for 
about 1 second (until LED turns 
off) and release. The instrument 
gives you three chances to find the 
correct file, if it does not you must 
format whatever card is there to 
begin a new recording session.

Mode LED will not change from 
error state (orange).

This can be caused by switching 
memory cards during a power failure 
without giving the instrument a 
chance to close the data file.

Remove the memory card and 
unplug the device. Restore power 
to the device (LED should turn 
green). Press and hold the control 
button for about 1 second (until 
LED turns off) and release. If LED 
is orange, press it again. When 
LED turns green reformat your 
memory card.

When memory card is inserted 
into a reader a “not formatted” 
error is seen.

Dependent upon the reader being 
used.

Sometimes the driver for an SD 
card reader appears “dead.” 
Reboot your PC.

When attempting to read the mem-
ory card using a card reader, the 
PC takes an interminably long 
time to open the data.

Dependent upon the memory card, 
card reader, and the PC you are using. 
The amount of time it takes to open 
the card will vary.

Using the Lock feature on an SD 
could speed up the process. Be 
sure to try that before purchasing 
new equipment.
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If power down occurs unexpectedly while recording to SD
The Stand-alone models have a built-in file protection feature. If power is lost while recording, all data—prior to up 
to 255 samples from the power failure—is available. If power is lost for any reason, the data file will be closed and 
saved and a new data file will be started when power is restored (Mode LED will flash red @ 1 Hz) if that option is 
selected in the Hardware Manager Stand-alone setup.

If the memory card is full, the Mode LED will quickly flash orange and then green and will not record new data until 
reformatted. Circular memory configuration may still be used if the memory card has not started to wrap the data (i.e., 
as long as the card is not full) and will only wrap data in the available space.

When recording at low sample rates be aware that the memory card must acquire 256 samples before it actually com-
mits them to memory. For example, if you are recording one channel at 1 sample per second and power down occurs 
unexpectedly, you could lose up to 255 seconds (4 minutes and 15 seconds) of data (255 samples). Use the following 
formula to determine the maximum amount of data loss at power failure.

Note: Clean and solid power on/off (no slow charging and no ringing) required for new file on power interruption. 
Once power is on, power interrupt cannot happen again within 5 seconds. If persistent failure upon power interrup-
tion occurs, consider a universal power supply (UPS).

Note: Switching memory cards before power is restored is not suggested because the data logger will automatically 
attempt to close the file. Leave the memory card in until power is restored, then allow the instrument to close the data 
file. After a new file has begun, stop recording. The memory card may now be removed and read for analysis.

WINDAQ Waveform Browser for SD
All files recorded in Stand-alone data logger operating mode (data saved to SD—.wdc files) must be reviewed in 
WINDAQ Waveform Browser for SD. Data files recorded using WINDAQ Acquisition software (PC operation—.wdq 
files) must be reviewed in the standard WINDAQ Waveform Browser. Even if connected to a PC, WINDAQ Waveform 
Browser cannot eavesdrop on the data being recorded to your memory card. Recording must be stopped and the file 
must be closed to review the data.

After viewing data files through a 
card reader, upon initiating a 
recording session, the LED blinks 
orange then turns green.

The instrument has a unique file sys-
tem. When the data on the memory 
card opens in Windows, sometimes 
Windows will modify the file system.

You must reformat the card. To 
prevent further instances of this 
error, use the Lock provided on 
your SD card. With some SD cards 
you will have to reformat the card 
with each subsequent use.

When attempting to read the mem-
ory card using a card reader, the 
data file is huge (completely fills 
up the memory card) and the 
actual waveform data is difficult 
to find.

The instrument did not have a chance 
to properly close the file.

If you have not started using the 
instrument with a different mem-
ory card, reinsert the card and 
press the LED for about 1 second 
(until LED turns off) and release. 
The LED should be green indicat-
ing the file is closed and can be 
read.

If you have already configured and 
used the instrument again, the file 
can no longer be closed and you 
will have to search for it and cut/
paste the data into a new file.

255
Throughput Rate
---------------------------------------- Seconds of data that COULD be lost=
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DI-718B and DI-718Bx stand-alone data loggers place 256 equally-spaced event markers into all data files when 
recording to SD (except when using Remote Controls). This allows easier navigation through larger files. Click on 
Event Markers in the View menu to access and “jump to” each of these event markers.

The Calculate command in the File menu is unavailable in WINDAQ Waveform Browser for SD. Use the Save As... 
command in the File menu to save data to another format in order to perform Advanced CODAS calculations (File > 
Save As... > option 8) CALC is still available). Converting data from a .wdc format to a .wdq format is also possible 
with File > Save As.... Choose option 2) Binary (with CODAS header) and enter a file name with .wdq as the exten-
sion. For more information regarding the Save As... function, consult your WINDAQ Waveform Browser Help File.

A stand-alone data file acquired with remote events or storage enabled displays an hourglass when opening while it 
scans for event marks and timestamps in order to construct an Event Marker table. Use File Save or the "Save All" 
button when changing files or exiting to write the Event Marker table to the file and avoid a delay when the file is 
opened again.
Operation
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6. Block Diagram
DI-718B Models

SD 
Code 

SD 

5V

4.7K

5V

4.7K
Block Diagram
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DI-718Bx Models

SD 
Code 

SD 

Digital I/O
(Rear Panel Access)

*Stand-alone models only
Block Diagram
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7. Accessories
DI-705 (for DI-718Bx models only)
Plug the DI-705 into CABL-7 and connect CABL-7 to the Digital I/O and Monitor Out port on the rear panel of the 
DI-718Bx to access the Digital I/O and Monitor Out port (see “DI-718Bx Rear Panel” on page 25 for location). The 
screw terminals accept 16-22 gauge wire and each is silk-screened with a pin number (below). 

The Digital I/O may be enabled as Channel 17. Note: The Digital I/O is not available in stand-alone mode — Except 
for Remote Start/Stop (DI/O0) and Remote Event (DI/O1). Use the table below for pinout of the DI-705 (screw termi-
nal in bold).

1 N.C. 11 CH16 21 DI/O6 31 CH7

2 DI/O5 12 CH15 22 DI/O2 32 CH6

3 DI/O3 13 CH14 23 DI/O0 33 CH5

4 DI/O1 14 CH13 24 DI/O2 34 CH4

5 DI/O3 15 CH12 25 DI/O0 35 CH3

6 DI/O1 16 CH11 26 DI/O4 36 CH2

7 Power GND 17 CH10 27 DI/O7 37 CH1

8 DI/O6 18 CH9 28 AGD

9 N.C. 19 AGD 29 DI/O7

10 DI/O5 20 DI/O4 30 CH8

Signal connections are made 
to the screw terminals. 

Connect to “Digital I/O and 
Monitor Out” port on rear of 

DI-718BX Instrument
Accessories
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DI-8B30/31 Analog Voltage Input Modules, 3Hz Bandwidth
Each DI-8B30 or DI-8B31 module isolates, filters and amplifies a voltage input signal and provides an analog voltage 
output.
Signal filtering is accomplished with a three-pole filter optimized for time and frequency response which provides 
70dB of normal-mode-rejection at 60Hz. One pole of this filter is on the field side of the isolation barrier for anti-
aliasing, and the other two are on the system side.
A special input circuit on the DI-8B30 and DI-8B31 modules provides protection against accidental connection of 
power-line voltages up to 240VAC.
Isolation is provided by optical coupling to suppress transmission of common mode spikes or surges. The module is 
powered from +5VDC, ±5%.

:
Ordering Information

MODEL INPUT RANGE OUTPUT RANGE
DI-8B30-01 -10mV to +10mV -5V to +5V
DI-8B30-02 -50mV to +50mV -5V to +5V
DI-8B30-03 -100mV to +100mV -5V to +5V
DI-8B31-01 -1V to +1V -5V to +5V
DI-8B31-02 -5V to +5V -5V to +5V
DI-8B31-03 -10V to +10V -5V to +5V
DI-8B31-07 -20V to +20V -5V to +5V
DI-8B31-09 -40V to +40V -5V to +5V
DI-8B31-12 -60V to +60V -5V to +5V
Accessories
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DI-8B32 Analog Current Input Modules
Each DI-8B32 module isolates, filters and amplifies a process current input signal and provides an analog voltage 
output.

Current to voltage conversion is accomplished internal to the module to ensure high accuracy.

Signal filtering is accomplished with a three-pole filter optimized for time and frequency response which provides 
70dB of normal-mode-rejection at 60Hz. One pole of this filter is on the field side of the isolation barrier for anti-
aliasing, and the other two are on the system side.

A special input circuit on the 8B32 module provides protection against accidental connection of power-line voltages 
up to 30VAC. Isolation is provided by optical coupling to suppress transmission of common mode spikes or surges. 
The module is powered from +5VDC, ±5%.

Ordering Information
MODEL INPUT RANGE OUTPUT RANGE

DI-8B32-01 4mA to 20mA 0V to +5V
DI-8B32-02 0mA to 20mA 0V to +5V
Accessories
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DI-8B33 True RMS Input Modules
Each DI-8B33 True RMS input module provides a single channel of AC input which is converted to its true RMS DC 
value, filtered, isolated, amplified, and converted to a standard process voltage or current output.

The field voltage or current input signal is processed through a pre-amplifier and RMS converter on the field side of 
the isolation barrier. The converted DC signal is then chopped by a proprietary chopper circuit and transferred across 
the transformer isolation barrier, suppressing transmission of common mode spikes and surges. The computer side 
circuitry reconstructs, filters, and converts the signal to an industry standard output of 0 to 5 VDC.

Special input circuits provide protection against accidental connection of power line voltages up to 300VAC and 
against transient events defined by ANSI/IEEE C37.90.1

Ordering Information
MODEL INPUT RANGE OUTPUT RANGE

DI-8B33-01 0mV to 100mV 0V to +5V
DI-8B33-02 0V to 1V 0V to +5V
DI-8B33-03 0V to 10V 0V to +5V
DI-8B33-04 0V to 150V 0V to +5V
DI-8B33-05 0V to 300V 0V to +5V
Accessories
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DI-8B34 Linearized 2- or 3-Wire RTD Input Modules
Each DI-8B34 module isolates, filters, amplifies, and linearizes a single channel of temperature input from an RTD 
and provides an analog voltage output.

RTD excitation is provided from the module using two matched current sources. When using a 3-wire connection, 
this method allows equal currents to flow through the sensor leads, cancelling the effects of lead resistances. The 
excitation currents are small (0.25mA) which minimizes the self-heating of the RTD.

Signal filtering is accomplished with a three-pole filter optimized for time and frequency response which provides 
70dB of normal-mode-rejection at 60Hz. One pole of this filter is on the field side of the isolation barrier for anti-
aliasing, and the other two are on the system side.

A special input circuit on the DI-8B34 module provides protection against accidental connection of power-line volt-
ages up to 240VAC. Clamp circuits on the I/O and power terminals protect against harmful transients.

Ordering Information
MODEL INPUT RANGE OUTPUT RANGE ACCURACY*

DI-8B34-01 -100°C to +100°C (-148°F to +212°F) 0V to +5V ±0.20°C
DI-8B34-02 0°C to +100°C (+32°F to +212°F) 0V to +5V ±0.15°C
DI-8B34-03 0°C to +200°C (+32°F to +392°F) 0V to +5V ±0.20°C
DI-8B34-04 0°C to +600°C (+32°F to +1112°F) 0V to +5V ±0.45°C

* Includes conformity, hysteresis and repeatability.
Accessories
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DI-8B35 Linearized 4-Wire RTD Input Modules
In RTD temperature measurement applications requiring a very high level of accuracy, the DI-8B35 4-Wire RTD 
input module offers a significant advantage over 3-wire measurement techniques (see block diagram). The DI-8B35 
measures only the voltage dropped across the RTD and almost completely ignores the resistance or length of the RTD 
lead wires. The DI-8B34 3-Wire RTD module provides lead resistance compensation, but requires equal lead resis-
tances, while the DI-8B35 does not require matched lead resistances.

Each DI-8B35 module isolates, filters, amplifies, and linearizes a single channel of temperature input from an RTD 
and provides an analog voltage output.

RTD excitation is provided from the module using a precision current source. Excitation current does not flow in the 
input signal leads, which allows RTD measurements to be made independent of lead resistance. The excitation cur-
rents are small (0.25mA) which minimizes self-heating of the RTD.

Signal filtering is accomplished with a three-pole filter optimized for time and frequency response which provides 
70dB of normal-mode-rejection at 60Hz. One pole of this filter is on the field side of the isolation barrier for anti-
aliasing, and the other two are on the system side.

A special input circuit on the DI-8B35 module provides protection against accidental connection of power-line volt-
ages up to 240VAC. Clamp circuits on the I/O and power terminals protect against harmful transients.

Ordering Information
MODEL INPUT RANGE OUTPUT RANGE ACCURACY*

DI-8B35-01 -100°C to +100°C (-148°F to +212°F) 0V to +5V ±0.20°C
DI-8B35-02 0°C to +100°C (+32°F to +212°F) 0V to +5V ±0.15°C
DI-8B35-03 0°C to +200°C (+32°F to +392°F) 0V to +5V ±0.20°C
DI-8B35-04 0°C to +600°C (+32°F to +1112°F) 0V to +5V ±0.45°C

* Includes conformity, hysteresis and repeatability.
Accessories
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DI-8B36 Potentiometer Input Modules
Each DI-8B36 module isolates, filters and amplifies a single channel of potentiometer input and provides an analog 
voltage output.

Excitation for the potentiometer is provided by using two matched current sources. When using a 3-wire connection, 
this method allows equal currents to flow through the sensor leads, cancelling the effects of lead resistances. The 
excitation currents are small (0.25mA) which minimizes the self-heating of the potentiometer.

Signal filtering is accomplished with a three-pole filter optimized for time and frequency response which provides 
70dB of normal-mode-rejection at 60Hz. One pole of this filter is on the field side of the isolation barrier for anti-
aliasing, and the other two are on the system side.

A special input circuit on the DI-8B36 module provides protection against accidental connection of power-line volt-
ages up to 240VAC. Clamp circuits on the I/O and power terminals protect against harmful transients.

Ordering Information
MODEL INPUT RANGE OUTPUT RANGE

DI-8B36-01 0 to 100 0V to +5V
DI-8B36-02 0 to 500 0V to +5V
DI-8B36-03 0 to 1k 0V to +5V
DI-8B36-04 0 to 10k 0V to +5V
Accessories
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DI-8B38 Strain Gage Input Modules, Narrow & Wide Bandwidth
Each DI-8B38 module isolates, filters and amplifies a full-bridge strain gage input signal and provides an analog volt-
age output.

The 8B38 can interface to transducers with a nominal resistance of 100 to 10k. Bridge excitation is provided from the 
module with a stable 10.00V or 3.33V source. Full scale sensitivities of 2mV/V and 3mV/V are offered as standard.

Signal filtering is accomplished with a five-pole filter optimized for time and frequency response which provides 
100dB per decade of normal-mode rejection above the filter cutoff frequency. One pole of this filter is on the field 
side of the isolation barrier for anti-aliasing, and the other four are on the system side.

A special input circuit on the DI-8B38 module provides protection against accidental connection of power-line volt-
ages up to 240VAC. Clamp circuits on the I/O and power terminals protect against harmful transients.

Isolation is provided by optical coupling to suppress transmission of common mode spikes or surges. The module is 
powered from +5VDC, ±5%.

Ordering Information
MODEL BANDWIDTH INPUT RANGE EXCITATION OUTPUT RANGE

DI-8B38-01 3kHz -10mV to +10mV 3.333V at 3mV/V Sensitivity -5V to +5V
DI-8B38-02 3kHz -30mV to +30mV 10.0V at 3mV/V Sensitivity -5V to +5V
DI-8B38-05 3kHz -20mV to +20mV 10.0V at 2mV/V Sensitivity -5V to +5V
DI-8B38-31 3Hz -10mV to +10mV 3.333V at 3mV/V Sensitivity -5V to +5V
DI-8B38-32 3Hz -30mV to +30mV 10.0V at 2mV/V Sensitivity -5V to +5V
DI-8B38-35 3Hz -20mV to +20mV 10.0V at 2mV/V Sensitivity -5V to +5V
Accessories
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DI-8B40/41 Analog Voltage Input Modules, 1kHz Bandwidth
Each DI-8B40 and DI-8B41 module isolates, filters, and amplifies a voltage input signal and provides an analog volt-
age output.

Signal filtering is accomplished with a multiple pole filter optimized for time and frequency response which provides 
70dB of normal-mode-rejection at 60Hz. One pole of this filter is on the field side of the isolation barrier for anti-
aliasing, and the remaining poles are on the system side.

A special input circuit on the DI-8B40 and DI-8B41 modules provides protection against accidental connection of 
power-line voltages up to 240VAC. Clamp Circuits on the I/O and power terminals protect against harmful transients.

Isolation is provided by optical coupling to suppress transmission of common mode spikes or surges. The module is 
powered from +5VDC, ±5%.

Ordering Information
MODEL INPUT RANGE OUTPUT RANGE

DI-8B40-01 -10mV to +10mV -5V to +5V
DI-8B40-02 -50mV to +50mV -5V to +5V
DI-8B40-03 -100mV to +100mV -5V to +5V
DI-8B41-01 -1V to +1V -5V to +5V
DI-8B41-02 -5V to +5V -5V to +5V
DI-8B41-03 -10V to +10V -5V to +5V
DI-8B41-07 -20V to +20V -5V to +5V
DI-8B41-09 -40V to +40V -5V to +5V
DI-8B41-12 -60V to +60V -5V to +5V
Accessories
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DI-8B42 2-Wire Transmitter Interface Modules
Each DI-8B42 module provides power to a current transmitter, then isolates, filters and amplifies the resulting pro-
cess current input signal and provides an analog voltage output.

Current to voltage conversion is accomplished internal to the module to ensure high accuracy.

Signal filtering is accomplished with a three-pole filter optimized for time and frequency response which provides 
60dB per decade of normal-mode rejection above 100Hz. One pole of this filter is on the field side of the isolation 
barrier for anti-aliasing, and the other two are on the system side.

A special input circuit on the DI-8B42 module provides protection against accidental connection of power-line volt-
ages up to 40VAC. Clamp circuits on the I/O and power terminals protect against harmful transients.

Isolation is provided by optical coupling to suppress transmission of common mode spikes or surges. The module is 
powered from +5VDC, ±5%.

Ordering Information
MODEL INPUT RANGE OUTPUT RANGE

DI-8B42-01 4mA to 20mA 0V to +5V
DI-8B42-02 4mA to 20mA +1V to +5V
Accessories
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DI-8B43 DC LVDT Input Modules
Each 8B43 module isolates, filters, and amplifies a voltage input signal and provides an analog voltage output.

The 8B43 can interface to transducers that will operate on a 10V excitation voltage and up to 20mA of excitation cur-
rent.

Signal filtering is accomplished with a 5-pole filter optimized for time and frequency response which provides 
100dBper decade of normal-mode rejection above 1kHz. One pole of this filter is on the field side of the isolation bar-
rier for anti-aliasing, and the other four are on the system side.

A special input circuit on the 8B43 modules provides protection against accidental connection of power-line voltages 
up to 240VAC. Clamp circuits on the I/O and power terminals protect against harmful transients.

Isolation is provided by transformer coupling to suppress transmission of common mode spikes or surges. The mod-
ule is powered from +5VDC, ±5%.

Ordering Information
MODEL INPUT RANGE OUTPUT RANGE

DI-8B43-01 -1V to +1V -5 to +5V
DI-8B43-02 -2V to +2V -5 to +5V
DI-8B43-03 -3V to +3V -5 to +5V
DI-8B43-04 -4V to +4V -5 to +5V
DI-8B43-05 -5V to +5V -5 to +5V
DI-8B43-11 -1V to +1V 0 to +5V
DI-8B43-12 -2V to +2V 0 to +5V
DI-8B43-13 -3V to +3V 0 to +5V
DI-8B43-14 -4V to +4V 0 to +5V
DI-8B43-15 -5V to +5V 0 to +5V
Accessories
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DI-8B45 Frequency Input Modules
Each DI-8B45 module isolates and conditions a frequency input signal and provides an analog voltage output.

The frequency input signal can be either a TTL level or zero crossing with as little as ±100mV amplitude. Input cir-
cuitry for each signal type has built-in hysteresis to prevent spurious noise from corrupting the module output. TTL 
signals are applied to the + and - terminals while zero crossing signals are applied to the +EXC and - terminals. Ref-
erence the block diagram.

A 5V excitation is available for use with magnetic pick-up or contact closure type sensors. The excitation is available 
on the -EXC terminal with return on the - terminal.

A special input circuit on the DI-8B45 modules provides protection against accidental connection of power-line volt-
ages up to 240VAC. Clamp circuits on the I/O and power terminals protect against harmful transients.

Isolation is provided by optical coupling to suppress transmission of common mode spikes or surges. The module is 
powered from +5VDC, ±5%.

Ordering Information
MODEL INPUT RANGE OUTPUT RANGE EXCITATION

DI-8B45-01 0 to 500Hz 0 to +5V +5V at 8mA max
DI-8B45-02 0 to 1kHz 0 to +5V +5V at 8mA max
DI-8B45-03 0 to 2.5kHz 0 to +5V +5V at 8mA max
DI-8B45-04 0 to 5kHz 0 to +5V +5V at 8mA max
DI-8B45-05 0 to 10kHz 0 to +5V +5V at 8mA max
DI-8B45-06 0 to 25kHz 0 to +5V +5V at 8mA max
DI-8B45-07 0 to 50kHz 0 to +5V +5V at 8mA max
DI-8B45-08 0 to 100kHz 0 to +5V +5V at 8mA max
Accessories
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DI-8B47 Linearized Thermocouple Input Modules
Each DI-8B47 module isolates, filters, amplifies, and linearizes a single channel of temperature input from a thermo-
couple and provides an analog voltage output.

Linearization is accomplished using a four breakpoint piece wise linear approximation.

The DI-8B47 can interface to industry standard thermocouple type J, K, and T and has an output signal of 0V to +5V. 
Each module is cold-junction compensated to correct for parasitic thermocouples formed by the thermocouple wire 
and screw terminals on the mounting backpanel. Upscale open thermocouple detect is provided by an internal pull-up 
resistor.

Signal filtering is accomplished with a three-pole filter optimized for time and frequency response which provides 
70dB of normal-mode-rejection at 60Hz. One pole of this filter is on the field side of the isolation barrier for anti-
aliasing, and the other two are on the system side.

A special input circuit on the DI-8B47 module provides protection against accidental connection of power-line volt-
ages up to 240VAC.

Ordering Information
MODEL TYPE INPUT RANGE ACCURACY*

DI-8B47J-01 Type J 0°C to +760°C (+32°F to +1400°F) ±0.24% ±1.82°C
DI-8B47J-02 Type J -100°C to +300°C (-148°F to +572°F) ±0.24% ±0.96°C
DI-8B47J-03 Type J 0°C to +500°C (+32°F to +932°F) ±0.21% ±1.05°C
DI-8B47J-12 Type J -100°C to +760°C (-148°F to +1400°F) ±0.24% ±2.10°C
DI-8B47K-04 Type K 0°C to +1000°C (+32°F to +1832°F) ±0.24% ±2.40°C
DI-8B47K-05 Type K 0°C to +500°C (+32°F to +932°F) ±0.24% ±1.05°C
DI-8B47K-13 Type K -100°C to +1350°C (-148°F to +2462°F) ±0.24% ±3.60°C
DI-8B47K-14 Type K 0°C to +1200°C (+32°F to +2192°F) ±0.24% ±2.88°C
DI-8B47T-06 Type T -100°C to +400°C (+32°F to +392°F) ±0.48% ±2.40°C
DI-8B47T-07 Type T 0°C to +200°C (+32°F to +392°F) ±0.39% ±0.75°C

*Includes conformity, hysteresis and repeatability. Does not include CJC accuracy.
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Each DI-8B50 and DI-8B51 module isolates, filters, and amplifies a voltage input signal and provides an analog volt-
age output.

Signal filtering is accomplished with a multiple pole filter optimized for time and frequency response which provides 
70dB of normal-mode-rejection at 60Hz. One pole of this filter is on the field side of the isolation barrier for anti-
aliasing, and the remaining poles are on the system side.

A special input circuit on the DI-8B50 and DI-8B51 modules provides protection against accidental connection of 
power-line voltages up to 240VAC. Clamp circuits on the I/O and power terminals protect against harmful transients.

Isolation is provided by optical coupling to suppress transmission of common mode spikes or surges. The module is 
powered from +5VDC, ±5%.

Ordering Information
MODEL INPUT RANGE OUTPUT RANGE

DI-8B50-01 -10mV to +10mV -5V to +5V
DI-8B50-02 -50mV to +50mV -5V to +5V
DI-8B50-03 -100mV to +100mV -5V to +5V
DI-8B51-01 -1V to +1V -5V to +5V
DI-8B51-02 -5V to +5V -5V to +5V
DI-8B51-03 -10V to +10V -5V to +5V
DI-8B51-07 -20V to +20V -5V to +5V
DI-8B51-09 -40V to +40V -5V to +5V
DI-8B51-12 -60V to +60V -5V to +5V
Accessories
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